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Lab 6
The Tangent

Objectives

1. Tovisualize the concept of the tangent.
2. To define the slope of the tangent line.
3. Todevelop adefinition of the tangent line to a curve at a point.

The goal of thislab isto develop a mathematically accurate definition of the tangent line
toacurve at a point. Thefirst part of this lab will take you through a visual exploration
that will help you develop an intuition about the concept of the tangent line. Based on
this intuition, you will be asked to give an accurate definition of the tangent line. In the
second part of the lab, you will test the accuracy of your “tangent line” definition on
other examples and, if necessary, you will have the opportunity to revise your definition
based on the information obtained from these examples.

Exploration 1 Secant Linesand the Tangent Line

A secant line is aline that passes through two different points on a curve.

In this exploration, you want to use a particular set of secant lines to help you formulate
adefinition of the tangent line to a curve at a point.

L=~ Files This lab requires that you set a specific domain and range, select a
particular pen mode, and enter some functions and constants into

TEMATH. If you have been given the TEMATH file Lab 6 The Tangent,
skip the following set-up section and open thisfile by doing the following:

* If you have entered some objects into the Work window and it is not
empty, select Close Work ... from the File menu.

» Select Open Work ... from the File menu.

» Select thefile“Lab 6 The Tangent” and click the Open button.

Note that:

f (X = the example function under consideration

X, = the x-value of the point of interest on the curve

h = the horizontal distance between the two points on the secant line
m(h) = the slope function of the secant line

s(x) = the function representing the secant line
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Lab 6: The Tangent 2

If you have not been given the TEMATH file Lab 6 The Tangent, then
follow the instructions given below in the set-up section. Remember, you
can always save your work in afile on your own disk and open it at a later
time.

Set-up Section
First, you need to set up TEMATH by doing the following:

* Click off autoscaling, set the domainto —-5< x <5 and set therangeto -5< y<5.
» Select Pen... from the Options menu. Click the box containing the ~ to the left of

Highlight Selected Plot to remove the " . Click the OK button. All graphs will
now be plotted with athin line.

You will also need to enter some functions and constants into TEMATH to aid you in
your exploration. Instructions for doing this are given below and the goal is to have a
TEMATH Work window that looks like the following:

== Lab 6 The Tangent =—FI=
Info Declarations
< R | |s(#) = fiso) + m(h)(x-1o)  [1F]
F mih) = (flzo+h)-f(x0))/h
C h=1
C Ho = 1
« R | fl8)=(17+194-8"2-8"3)/10 ]
k= Im BE

Y ou will use the cubic polynomial function f (X) = (17+15x- x*- x°)/10 to generate a
curve for thisexploration. To enter this Function into TEMATH, do the following:

» Select New Function from the Work menu.

» Use the Delete key to delete the default name of the function in the Work window
and enter f(x) = (17+15x—x"2—x"3)/10. Pressthe Enter or Return key.

» Select Plot from the Graph menu.

L=~ After you've enter a function or constant into TEMATH's Work window,
you can easily change the definition of the function or constant by using
any of the Macintosh's editing features and then pressing the Enter key to
enter the new definition. Additionally, you can change the name a
function or constant as long as it has not been used in the definition of
another function or constant.
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L=~ Y ou can remove a function or constant from the Work window by clicking
on it to select it and then selecting Remove from the Work menu.

Later on in this lab you will need to overlay the plot of the secant line passing through
the two points (x,, f(X,)) and (x, + h, f(x, + h)) on top of the graph of f(X). To set up
TEMATH to do thisfor x, =1 and h =1, follow these instructions:

» Select New Constant from the Wor k menu.

» Déelete the default name of the constant in the Wor k window and enter xo = 1.
Pressthe Enter or Return key.

Select New Constant from the Wor k menu.

Delete the default name of the constant in the Work window and enter h = 1.
Pressthe Enter or Return key.

To help visualize the point of interest on the curve, draw a dot on the curve at x, =1 by
doing the following:

* Click inthe Graph window to make it the active window.
* Click the Coordinate tool [i:x]| in the Graph window.

» Position the cursor over the top portion of the Coordinate tool icon rws

and hold down the mouse button. Drag the cursor to the medium sized SO|Id dot on
the left side of the pop-up menu

()
P B
E & @ O
[#] = e o©

» Release the mouse button.

* Click in the Domain & Range window. Enter 1 into the “® =" cell in the lower
portion of the window. Pressthe Enter key. A dot should be drawn on the curve at
the point (1, 3).

In this exploration, you will need to find the slope of many different secant lines so it

M *M) - 1) {10 TEMATH by

will be beneficial to enter the slope equation m= h

following these instructions:

» Select New Function from the Work menu.

» Delete the default name of the function in the Work window and enter
m(h) = (f(xoth)—f(x0))/h. Note that we entered the slope as a function of h, where
h is the horizontal distance between the two points on the curve through which we
want to draw the secant line.

* Pressthe Enter or Return key.
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The point-slope form of the equation of the secant line passing through the two points
(%, T(X%,)) and (x, +h,f(x,+h)) is y=f(x,)+m(x- x). Enter this equation into
TEMATH as the function y = s(x) by following these instructions:
» Select New Function from the Work menu
* Delete the default name of the function in the Work window and enter
s(x) = f(xo0) + m(h)(x—xo0). Pressthe Enter or Return key.

Y ou have now completed the set up portion of this lab.

The purpose of this exploration is to see what happens to the secant lines as the value of
h gets smaler and smaller, that is, as the magnitude of h gets closer and closer to zero.
To begin, overlay the plot of the secant linefor h =1 by doing the following:

* If 5(x) in not selected in the Work window, then click on it to select it.

» Select Overlay Plot from the Graph menu. The secant line passing through the
points (1, 3) and (2,3.5) will be plotted.

To make h smaller in magnitude and to overlay the plot of the new secant line, do the
following:

» Change the value of h to 0.5 inthe Work window, that is, change h=1 to h=0.5.
Remember to press the Enter key after you make this change.

* Click in the cell in the Work window that contains the secant line function s(x).
This selects the function for plotting.

» Change the plot color/pattern of s(x) by clicking on the vertical line immediately to
theleft of s(x) inthe Work window. Thiswill help you to distinguish the different
secant lines that will be plotted in the Graph window.

» Select Overlay Plot from the Graph menu.
Repeat the above sequence of instructionsfor h=0.1, 0.01, and 0.001.

1. Describe what happens to the graphs of the secant lines as the value of h gets closer and
closer to zero, that is, as the two points on the curve get closer and closer to each other?
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In everything that you have done so far, the second point on the secant line has always
been to the right of the point (x,, f(X,)) (since h was positive). If you let h equal a

negative number, then the point (X, + h, f(x,+h)) will be to the left of the point
(%5, T(X,)). To see what happens to the secant lines for negative values of h, repeat the
“moving secant line” process described above, but this time for negative values of h.

However, before you do this, click in the Work window to make it active, select f(x), and
plot f(x). This will clean up the Graph window by erasing the previously drawn secant
lines. Next draw the dot at the point on the curve and draw the secant lines for
h=-1,- 05,- 0.1,- 0.01, and - 0.001.

2. Describe what happens to the graphs of the secant lines as h gets closer and closer to

zero fromthe negative direCtiON?.......c.oi i e

To help you formulate an accurate definition of the tangent line, do the following:

» Plot f(x). Thiswill clear all the secant lines from the Graph window.
* Overlay the plots of the secant linesfor h=0.001 and h =- 0.001.

3. What do you observe about these two secant [ineS?...........coovviiiiiiiiiiiiiiieeee .

Let's call the line that all the secant lines are approaching as h gets closer and closer to
zero the tangent line.

5. Using words, give an accurate definition for the tangent line to the curve y = f(x) at the
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In order to find the equation of the tangent line, you need to know a point the tangent
line passes through and the slope of the tangent line. Since all the secant lines pass
through the point (x,, f(x,)) = (1,3), you only need to find the slope. Since the secant
lines are approaching the tangent line as h gets closer and closer to zero, the slope of
these secant lines should also be getting closer and closer to the slope of the tangent line.
To find thisslope, you need to let h get closer and closer to zero and calculate the slopes
of the corresponding secant lines. Remember, the Work window should already contain
the slope function m(h) for the secant lines. To calculate the slopes for different values

of h, do the following:

» Select Calculators — Expression Calculator from the Work menu. The
Expression Calculator window will open.

 Enter the expression m(1) and press the Enter key (make sure you press the Enter
Key and not the Return Key). The slope of the secant line for h =1 will be written
on the next line. Record the value of this slope into the table given in question 6.

» Change m(1) to m(0.1). Make sure the flashing cursor remains on the same line as
m(0.1). Pressthe Enter key. Repeat thisfor m(0.01), m(0.001), m(0.0001),

m(=1), m(=0.1), m(~0.01), m(-0.001), and m(~0.0001).

6. a Enter the slopes of the secant lines into the following table:

h m(h) h m(h)
1.0 1.0
0.1 0.1
0.01 —0.01
0.001 —0.001
0.0001 —0.0001

b) As h gets closer and closer to zero from the positive direction, what value are the

slopes of the secant lines getting CloSeto? ...
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c) As h gets closer and closer to zero from the negative direction, what value are the
slopes of the secant lines getting CloSEtO? ..o,

d) What value would you give to the slope of thetangent lin€?.........................o.ls

7. Whatisthe equation of thetangent lIN€2............ccooiii i,

Exploration 2 Testing Your Definition of the Tangent

The goal of this exploration is to test your definition of the tangent line by using some
other example functions. The first example consists of the function

f (X = (X - 3x* +6x +6)/10 and the point onitscurve at x, = 1. To enter and plot this
function, do the following:

 Change the f(x) function in the Work window tof(x) = (x"3-3x"2+6x+6)/10.
» Select Plot from the Graph menu.

Using the process described in the first exploration, answer the following questions.

1. Describe what happens to the graphs of the secant lines as h gets closer and closer to

To help you visualize the concept of the tangent line, do the following:
* Plot f(x).
* Overlay the plots of the secant linesfor h=0.001 and h =- 0.001.

2. What do you observe about these two secant [ines?.............oooiiiiiiiiiii .
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3. a) Enter the dopes of the secant lines into the following table:

h m(h) h m(h)
1 1
0.1 0.1
0.01 —0.01
0.001 ~0.001

b) As h gets closer and closer to zero from the positive direction (positive h), what
value are the slopes of the secant lines getting closeto? ...,
c) As h gets closer and closer to zero from the negative direction (negative h), what
value are the slopes of the secant lines getting closeto? ...,

d) Arethevaluesinb)and C)theSame?.......ccoviiiiiii i
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5. Doesyour original definition of the tangent line hold for thisexample?.....................

If not, explain why not and give anew definition..............c.oooeiiiiiiiiii i

Let'stry another example. Thistime, let f (X =|1- x*| and x, = 1.

* Change the f(x) function in the Work window tof(x) = abs(1-x"2).
* Select Plot from the Graph menu.

Using the process described in the first exploration (but only use h = 0.1, 0.01, 0.001,
-0.1, -0.01, and —-0.001), answer the following questions.

6. Describe what happens to the graphs of the secant lines as h gets closer and closer to

To help you visualize the concept of the tangent line, do the following:

Kowalczyk & Hausknecht 8/14/00



Lab 6: The Tangent 10

* Plot f(x).
* Overlay the plots of the secant linesfor h=0.001 and h =- 0.001.

7.  What do you observe about these two secant lines?............ccooieiiiiiiiiiiiie .

8. a) Enter the dopes of the secant lines into the following table:

h m(h) h m(h)
0.1 0.1
0.01 —0.01
0.001 ~0.001
0.0001 ~0.0001

b) As h gets closer and closer to zero from the positive direction (positive h), what
value are the slopes of the secant lines getting closeto?............ccccoviviiiiiiiinnnns
c) As h gets closer and closer to zero from the negative direction (negative h), what
value are the slopes of the secant lines getting closeto?............ccccovivviiiiiinnns

d) Arethevaluesinb)and ) thesame?..........ccoo i
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10. Doesyour definition of the tangent line hold for thisexample?...............ccooeeiennnn.

If not, explain why not and give anew definition..............c.oooeiiiiiiiiii i

Let'stry one more example. Thistime, let (X = 2(x- 1) +1 and x, = 1.

» Change the f(x) function in the Work window to f(x) = 2 rad(3, x-1) + 1. Note
that in TEMATH, the nth root of afunction (g(x))"" iswritten as rad(n, g(x)).
» Select Plot from the Graph menu.

Using the process described in the first exploration (but only use h = 0.1, 0.01, 0.001,
—0.1, -0.01, and —0.001), answer the following questions.

11. Describe what happens to the graphs of the secant lines as h gets closer and closer to

To help you visualize the concept of the tangent line, do the following:
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* Plot f(x).
* Overlay the plots of the secant linesfor h=0.001 and h =- 0.001.

12. What do you observe about these two secant [INeS?.........ovviiiiiiiiii i

13. a) Enter the slopes of the secant linesinto the following table:

h m(h) h m(h)
0.1 0.1

0.01 —0.01

0.001 ~0.001

0.0001 ~0.0001

b) As h gets closer and closer to zero from the positive direction (positive h), what
happensto the slopes of thesecant [INES? ..........ooiiii i

c) As h gets closer and closer to zero from the negative direction (negative h), what

happens to the slopes of thesecant [INES? ..........ooviii i
d) Arethere any similarities between the slopesinb) and C)?...............ooeiiiiiinnt.
14. @) Doesthiscurve have atangent lineat x, =17?........... Explain why or why not.....
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c) If thiscurve has atangent line at x, =1, is there anything that is different about it as

compared to the other tangent lines found previously?..........ccoovviiiiiiiiiiinnnnn.

15. Doesyour definition of the tangent line hold for thisexample?...............ccooeiinnnnn.

If not, explain why not and give a new definition

Kowalczyk & Hausknecht 8/14/00



